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Copyright Notice:

FJDynamics reserves the copyright for this manual and all content herein. No part of this

manual may be reproduced, extracted, reused, and/or reprinted in any form or by any

means without the prior written permission of FJDynamics.

This manual is subject to change without notice.

Read Before Use:

Operate in strict accordance with this software user manual.

If you have any questions during use, contact the service personnel.

Disclaimer:

 The purchased products, services, and features are stipulated by the contract. All or part

of the products, services, and features described in this manual may not be within the

scope of your purchase or usage. Unless otherwise specified in the contract, all the

content in this manual is provided "AS IS" without warranties of any kind, express or

implied.

 The content of this manual is subject to change due to product upgrades and other

reasons. FJDynamics reserves the right to modify the content of this manual without

notice.

 This manual only provides guidance for use of this product. Every effort has been made in

the preparation of this manual to ensure accuracy of the content, but no information in

this manual constitutes a warranty of any kind, express or implied.
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1 Overview
FJD Trion Model is point cloud processing software developed by FJ Dynamics Co., Ltd.

(FJDynamics), and can be used to visualize and process point cloud data obtained by a laser

scanner. Usually, such point cloud data includes a 3D point cloud and an optional 2D image

set. Each point in the point cloud includes its 3D coordinates and other properties, such as

intensity and surface normals. A point cloud can be visualized, rotated, translated, zoomed in,

and zoomed out in a 3D view area. The visualization effect can be enhanced in different ways,

for example, by changing the point size, intensity, colors, and visual angles.

To use FJD Trion Model correctly and efficiently, read this manual before use, so that you can

learn its modules, functions, features, and basic operation procedures. All features in this

manual are demonstrated in Windows 11. The operations in other operating systems are

similar, and are not described again.

FJD Trion Model supports the following features:

Point cloud

mapping

Supports offline reconstruction of point cloud data collected by the FJD

Trion S1 or FJD Trion P1 laser scanner.

Accuracy

verification

Supports plane and elevation accuracy verification, providing users with

more accurate and reliable data. Analyzes the point cloud quality by use

of horizontal and vertical slices.

View
Sets display colors of the point clouds and changes background color and

view angles, providing good user experience.

Point cloud

processing

Preprocesses raw point clouds with features such as point cloud

segmentation, thinning, clustering and SOR filter to satisfy different

scenario requirements.

Mesh processing
Creates triangular meshes from point clouds, and provides mesh

smoothing, andmesh sampling, improving data operation fluency.
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Measurement
Carries out measurements of point, length, height difference, angle, and

area, ensuring data accuracy.

Classification

Carries out classification in multiple indoor and outdoor scenarios to

automatically extract walls, floor, ceiling, grounds with different slopes,

and trees in point clouds.

Volume calculation
Measures volume of piles such as coal piles, granaries, and construction

earthwork.

Two-dimensional

vector graphic

drawing

Draws two-dimensional vector graphics based on point cloud slices to

reversely restore the plane drawings of the scanned objects.

Forestry data

processing
Obtains tree parameters and exports reports.
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2 FJD Trion Model

2.1 Configuration Requirements
FJD Trion Model must be run in the following environment:

1. Hardware:

Recommended configuration:

 Processor: Intel® CoreTM i7-10700 CPU@ 2.90 GHz (or an AMD CPU with equal performance)

 Memory: 32 GB

 Graphics card: NVIDIA GeForce GTX 1650 Ti 4G

 Hard disk drive: 64 GB

 Screen resolution: 1680× 1050 or above

Minimum configuration:

 Processor: Intel® Core TM i5-2300 CPU@ 3.10 GHz (or an AMD CPUwith equal performance) or

above

 Memory: 8 GB

 Graphics card: Graphics 630

 Hard disk drive: 32 GB

 Screen resolution: 1680× 1050 or above

2. Software:

 Operating system: Windows 8 or above (Windows 11 recommended)

2.2 Download
Download the FJD Trion Model package at:

https://www.fjdynamics.com/product/trion-s1-3d-lidar-scanner.html

mailto:处理器@2.90
mailto:i5-2300处理器@3.10
https://www.fjdynamics.com/product/trion-s1-3d-lidar-scanner.html
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2.3 Installation
1. Decompress the FJD Trion Model package, right-click , and select Run as

administrator.

Figure 1. Running the program

2. Select the setup language from "简体中文","English", "繁體中文", and "日本語", and click

OK.

Figure 2. Selecting the setup language

3. Select I accept the agreement to accept the License Agreement, and then click Next;

otherwise, the installation will be exited.

Figure 3. Accepting the license agreement
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4. Select the target installation location, and then click Next. You are recommended to

install FJD Trion Model in a drive (D drive recommended) other than C drive. Otherwise, a

running exceptionmay occur.

Figure 4. Selecting the installation location

5. Click Install. After the installation is completed, the window disappears, and a desktop

shortcut of FJD Trion Model is generated.

Figure 5. Installing FJD Trion Model

2.4 Update
FJD Trion Model only supports package updates currently. You can download the latest

package from FJDynamics' official website (https://www.fjdynamics.com).

2.5 Uninstallation
For example, in Windows 11, choose Start > All apps, find FJD Trion Model in the list,

right-click it, and select Uninstall.
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Figure 6. Uninstalling FJD Trion Model

You can also go to the software installation directory and click to uninstall it.

2.6 Activation
FJD Trion Model is a LiDAR point cloud processing software developed by FJDynamics, and

can be used only after activation. You can activate it by activation code or encryption lock

based on your actual needs. Go to the License setting window, choose Activation code to

activate by activation code, or choose Encryption Lock to activate by encryption lock, as

shown in Figure 7. When the software is activated successfully, the Licensemanagement

window is displayed as Figure 8 or Figure 9.

Figure 7. License setting

Figure 8. Successful activation by encryption lock
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Figure 9. Successful activation by activation code

Note: FJD Trion Model detects the encryption lock in real time, so always insert it to the USB

port during use.

When the license expires, contact FJDynamics technical support staff.

2.7 Language
FJD Trion Model supports simplified Chinese and English currently, and you can select the

language as needed.

Choose Help > Language, and select the language you prefer.

Figure 10. Selecting the language

2.8 Manual
The user manual is embedded in FJD Trion Model, and you can search this manual for specific

operations.

Click Help, and select Manual in the drop-down list.
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Figure 11. Manual
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3 Getting Started
3.1 Starting the Software
Double-click to start FJD Trion Model.

3.2 User Interface
The main user interface is shown below.

Figure 12. User interface

The following parts are included:
1 Menus 2 Help 3 Main toolbar

4 Project files 5 Properties 6 View area

7 Bottom bar

3.3 Shortcuts
Shortcut Description

Ctrl+O Opens a file.

Ctrl+S Saves the file.

Ctrl+click project files Selects multiple files.

Press down the left mouse button and drag in the 3D view area Rotates themodel.

Press down the right mouse button and drag in the 3D view area Translates themodel.

Scroll the scroll wheel of themouse in the 3D view area Zooms out and zooms in.

 










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4 File

4.1 Open
Description:

Opens a project file and displays it in the 3D view area.

Operation procedure:

1. Click to browse the files. Shortcut: Ctrl+O.

Figure 13. Opening a file

2. Select the target file, and click Open.

4.2 Open Recent
Description:

Displays directories of recent files, so that you can view the recent operation records.

Operation procedure:

 Choose File > Open Recent, and select the file to open.

Figure 14. Viewing recent files

 Click Clear Menu to clear the historical records.
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4.3 Save As
Description:
Saves the current entities.
Operation procedure:
1. Choose File > Save As to save the file. Shortcut: Ctrl+S.

Figure 15. Saving a file

2. Set the storage path, file name, and file type.
3. Click Save.

4.4 Settings
Description:

Sets the units, labels, classes and other parameters. The unit settings include the units of
length, area, radius, volume, and angle, the number of decimal digits, and whether the unit
label is shown after the numerical value.
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Operation procedure:

1. Choose File > Settings, and a popup window appears.

Figure 16. Settings

2. Choose Units to set the units of measurement and the number of decimal digits. The

figure below shows the different displays when Show unit label is selected or not.

Figure 17. Display of unit

3. The Classification tab shows the class ID, class name, and color. Click + Add to add a class,

double-click any class name with ID above 15 tomodify it, or click any color box to change

the color of the corresponding class.
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Figure 18. Classification settings

4. Choose Others to set the font size of prompts, point type, whether to show the middle

screen cross, and display brightness and contrast.

Figure 19. "Others" settings

The figure below shows different point types. The round point type is shown on the left, and

the square point type is shown on the right.
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Figure 20. Point types

5. To complete the settings, click OK. To restore the default settings, click Reset.

Figure 21. Restoring default settings

4.5 Close All
Description:
Removes all loaded entities, and restores the software to the default status.
Operation procedure:
1. Choose File > Close All, and a popup window appears.

Figure 22. Confirmation window
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2. Click OK to remove all loaded entities and restore the software to the default status, or

click Cancel to cancel this operation.

4.6 Quit
Description:

Quits the application.

Operation procedure:

1. After all data is processed and saved, choose File > Quit or click in the upper right
corner of the application window to quit.

Figure 23. Quitting the application

2. A popup window appears to ask you to confirm this action, to prevent you from quitting
the application accidentally or losing data. Click OK to quit. To quit directly afterwards,
select Never ask again.

Figure 24. Confirmation window
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5 Measurement
Description:

Obtains the requiredmeasurements in point clouds or meshes, including point properties,

distance, height difference, angle, and area. When a point cloud or mesh is selected under

Objects, click , and a measurement toolbar appears.

5.1 Point
Description:

Selects a point and displays its properties. This tool is activated by default and available for

point clouds and meshes.

Operation procedure:

1. Select a point cloud or mesh under Objects.

2. Click to show themeasurement toolbar.

3. Click , select a point, and a label as shown below appears, showing the coordinates of

the point.

Figure 25. Display of point properties
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5.2 Distance
Description:

Measures the distance between two points. Click to select the points. In the 2D view, the

measurements represent the planar distance, while in the 3D view, themeasurements

represent the distance between the points in the space. This tool is available for point clouds

and meshes.

Operation procedure:

1. Select a point cloud or mesh under Objects.

2. Click to show themeasurement toolbar.

3. Click , select two points, and a label as shown below appears, showing the distance

between the points selected. The following figures show the distance measured between

two points selected and the distance measured amongmultiple points selected.

Figure 26. Measuring the distance between two points
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Figure 27. Measuring the distance among multiple points

5.3 Height
Description:

Measures the height difference between two points. Click to select the points. This tool is

available for point clouds and meshes.

Operation procedure:

1. Select a point cloud or mesh under Objects.

2. Click to show the measurement toolbar.

3. Click , and select two points.

4. A straight line connecting the two points appears, with a label showing the height

difference.

Figure 28. Measuring the height difference
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5.4 Angle
Description:

Measures the angles between the selected three points. Click to select the points. This tool is

available for point clouds and meshes.

Operation procedure:

1. Select a point cloud or mesh under Objects.

2. Click to show the measurement toolbar.

3. Click , and select the first point.

4. Select the second point.

5. Double-click to select the third point and end the selection, and the measured angles

appear in the label, as shown in the figure below.

Figure 29. Measuring angles

5.5 Area
Description:

Measures the area covered by a triangle. Click to select points and draw a triangle. This tool is
available for point clouds and meshes.
Operation procedure:

1. Select a point cloud or mesh under Objects.
2. Click to show themeasurement toolbar.
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3. Click , and select three points. The figure below shows the area measurement in a point
cloud.

Figure 30. Measuring the area
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6 Clipping

6.1 Cropping
Description:

Selects and keeps one or more parts of a point cloud and deletes the remaining part.

Rectangular selection and polygonal selection are supported.

Operation procedure:

1. Select a point cloud under Objects.

2. Click , and a toolbar appears. Click to select a rectangle area, or click

to select a polygon area.

Figure 31. Point cloud before cropping

3. Click to keep the points falling inside the selected area, or click to keep the points

falling outside the selected area.
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4. Click to apply the result, or click to exit the cropping operation and restore the

initial state. To undo the action, click to restore the initial state. The following figure

shows the result of cropping out the selected area.

Figure 32. Cropping result

6.2 Segmentation
Description:

Segments a point cloud intomultiple clouds. Rectangular selection and polygonal selection

are supported.

Operation procedure:

1. Select a point cloud under Objects.

2. Click , and a toolbar appears. Click to select a rectangle area, or click

to select a polygon area.

Figure 33. Selecting the target area

3. Click to show the points falling inside the selected area.
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Figure 34. Showing the points inside the selected area

4. Click to show the points falling outside the selected area.

Figure 35. Showing the points outside the selected area

5. Click to apply the result, or click to exit the segmentation operation and restore the

initial state. To undo the action, click to restore the initial state.

Note:

When selecting a polygonal area, press Ctrl+Z to cancel the last point you select. This action is

repeatable and also supported by the polygonal selection tool in forestry editing and manual

classification.
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7 Start

7.1 Data Resolving
7.1.1 Point CloudMapping
Description:

Maps the raw data downloaded from FJD Trion S1 and FJD Trion P1.

Operation procedure:

1. Click on the Start tab, and the following window appears. Based on the data type,

select the device model, mapping mode, and scanning scene, and click Next. Or, click

Cancel to cancel mapping.

Figure 36. Point cloud mapping

2. Enter the project name, select the raw data file path and the project file path, and set the
reconstruction range and RTK fusion. To cancel mapping, click Cancel. To go back to the
previous screen, click Back.

Figure 37. Parameter settings
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3. Click Create to start data parsing. The Show pointcloud box is selected by default.
Deselect the box to not display the point cloud.

Figure 38. Data parsing progress

4. The mapping progress window appears after the data parsing is completed, and

disappears when the progress is 100%. The file list under Objects is updated, and the

mapping result is shown in the 3D view area.

Figure 39. Mapping progress

Parameters:

 Reconstruction: The default range is 1 m to 90 m.

 RTK fusion: Enable the function whenmapping outdoors with few features but a good

GNSS signal.

Note:

 Mapping data is saved in the same path as the raw data file, so to simplify themapping

process.

 During mapping, the point cloud and path data is shown for your view.
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7.1.2 RTK-based Registration
Description:

Aligns a point cloud with the point position data collected by an RTK receiver to represent the

point cloud in a geographic coordinate system.

Operation procedure:
1. Click on the Start tab, and the following window appears.

Figure 40. RTK-based registration

2. Select the receiver carryingmode, point cloud data, RTK data, geographic coordinate
system, and the point cloud storage location. Two point cloud data file formats are
supported: .las and .fjslam.tgz.

Figure 41. Registration settings
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3. Select Custom coordinate system and set the ellipsoid (XIAN80, WGS84, CGCS2000, BJ54,
GRS80, BESSEL, Krass, or Intl1910) and projectionmode (Gaussian or UTM projection),
when the geographic coordinate system list does not contain the desired coordinate
system.

Figure 42. Custom coordinate system
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4. Set projection parameters and seven parameters. Projection parameters include the
central meridian, origin latitude, false easting, false northing, and scale factor. Seven
parameters are the translation parameters (Dx, Dy, and Dz), rotation parameters (Rx, Ry,
and Rz), and scale (m) which can be imported in an .xlsx or .txt file or entered manually.

Figure 43. Setting projection parameters

Figure 44. Setting seven parameters

5. Click Register to start the registration. The settings window disappears and the following
window appears.

Figure 45. Registering the point cloud



29 ©2024 FJDynamics. All rights reserved.

FJD Trion Model Point Cloud Processing Software User Manual

6. If you are using an RTK receiver not from FJDynamics, click Advanced Settings on the
RTK-based Registration window, and enter the X/Y/Z axis offsets.

Figure 46. Advanced settings

7. All required fields on the RTK-based Registration windowmust be filled in. Otherwise, the
empty input box becomes red after you click Register.

Figure 47. Empty required fields

Note:

 When a point cloud data file is selected, the system automatically searches for any RTK

data file in the same folder, and fills in the data path into the RTK data input box if an RTK

data file is found.
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 When you select a compressed file of point cloud data downloaded from a laser scanner,

the RTK data input box becomes disabled, and the system automatically decompresses

the file and obtains the RTK data.

 You can use fuzzy search to select a geographic coordinate system, making the

registrationmuch easier.

 If the geographic coordinate system list does not contain the target coordinate system

that you need, you can use the RTK software provided by FJDynamics to create a target

coordinate file (*.fjdrtk) and import it for coordinate system transformation.

7.1.3 Camera Calibration
Description:

When scanning a scenario involving planar targets, the camera on the scanner captures a

video of the scenario, and the system works out the camera and scanner parameter matrix to

obtain the true color point cloud of better quality.

Operation procedure:
1. Select one or more (no more than three) point cloud files under Objects as required. To

select more files at a time, click the files one by one while pressing the Ctrl key.
2. Click on the Start tab, and the following window appears. Select the device model,

point cloud name, configuration file, and image file, and click Next.



31 ©2024 FJDynamics. All rights reserved.

FJD Trion Model Point Cloud Processing Software User Manual

Figure 48. Camera calibration window

3. Pick the same number of target points on both the preview image and the point cloud for
each state. If the calibration involves only one state, at least 12 target points must be
picked. If the calibration involves more than one state, at least 4 target points must be
picked for each state and the total number of target points picked must be no less than 12.
Otherwise the following message appears after you click Next.
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Figure 49. Picking target points

4. Click Browse to name the calibration file and select the storage path, click Save, and then
click OK.

Figure 50. Selecting the storage path

5. A message will show up indicating whether the calculation is successful or failed. When
the successful calculationmessage is displayed, click OK to colorize the point cloud.
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Figure 51. Successful calculationmessage

Figure 52. Unsuccessful calculation message

Note:
 Select the centers of planar targets as the target points.

 For the use of the camera, refer to the camera user manual. The camera calibration and

point cloud colorization are unavailable if the camera is not purchased along with the

scanner.

7.1.4 Point Cloud Colorization
Description:

Uses a series of algorithms to colorize the point cloud with true colors based on videos

captured during scanning.

Operation procedure:
1. Click on the Start tab, and the following window appears.
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Figure 53. Setting colorization parameters

2. Select the scanning scenario, device model, corresponding files for the basic data
(formats: las and fjdata), image data (format: mp4), and calibration parameters (format:
yaml), saving path, and coloring range. If any required field is empty, the input box
becomes red after you click OK.

Figure 54. Empty required field
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3. When all required files are selected, click OK to start the point cloud colorization. The
following window appears.

Figure 55. Colorizing the point cloud

4. The above window disappears when the colorization is completed. The colorized point
cloud is displayed in the 3D view area.

Figure 56. A colorized neighborhood point cloud

Figure 57. A colorized commercial street point cloud

5. The following window appears when the colorization fails. Ensure that the correct data is
selected and try again.

Figure 58. Unsuccessful point cloud colorization
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7.2 Point Processing
7.2.1 Moving Object Removal
Description:

Removes abnormal points caused by moving people or vehicles during scanning to ensure

better point cloud display. This solves problems of abnormal point cloud data and toomuch

noise when scanning crowded areas.

Operation procedure:

1. Click on the Start tab, and the following window appears. Select the point cloud data

and configuration files, and set the removal grade.

Figure 59. Moving object removal window

2. Click OK, and the removal progress window appears. The higher grade you set, the longer

time the removal takes and the better result you will get.

Figure 60. Moving object removal progress
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3. When the process is completed, the new point cloud is displayed in the 3D view area. The

following figures show a point cloud before and after moving object removal.

Figure 61. Before and after moving object removal

7.2.2 Rectification
Description:

Adjusts the normals of points on different planes according to the normal relationship of

coordinate axes, to reduce the impact of irregular points on the representation of point

clouds and improve the point cloud registration precision in certain scanning scenarios.

Operation procedure:

1. Select a point cloud file under Objects, click the Start tab, and then select Rectification.

2. The rectification of the selected point cloud starts. A window appears indicating that the

rectification is in progress.

Figure 62. Rectification in progress

3. The window disappears when the rectification is complete. A new point cloud file is added

to the list at the same level as the original point cloud file under Objects, and the file name

is original point cloud name.adjustX, where X indicates the number of rectifications that

have been done to the point cloud.
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4. After rectification, only the new point cloud is shown in the 3D view area.

5. The following window appears if the point cloud cannot be rectified.

Figure 63. Rectification error prompt

Note: Only one point cloud can be rectified at a time. Hidden point clouds must be shown

before they can be rectified.

Figure 64. Effects before and after point cloud rectification

7.2.3 Delete Outliers
Description:

As the scanner generally generates point clouds of different densities, and there are

unexpected points in the point clouds due to various external factors, to ensure accuracy, the

outliers need to be filtered out. This function removes the outliers based on the statistical

results.

Operation procedure:

1. Select a file under Objects.

2. Click , and the following window appears. Set the parameters, and click OK.
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Figure 65. Outlier deletion screen

3. The following figures show the effects before and after outliers are deleted.

Note: The number of outliers that are deleted is not directly related to the number of

evaluation points. The higher the deletion level, themore the outliers deleted.

Figure 66. Before outliers are deleted

Figure 67. After outliers are deleted
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7.3 Registration
7.3.1 Point Cloud Registration
Description:

The scanning of a large-scale scenario is often divided intomultiple projects, generating

separate point clouds. To obtain the complete point cloud data, you need to register the

point clouds using the feature points in the overlapping area, the spherical targets, and the

planar targets. The following is the procedure of registration when the control points are

picked by clicking.

Operation procedure:

1. Hold down the Ctrl key and select the two point clouds to be registered under Objects.

Click to open the Point Cloud Registration window.

Figure 68. Point cloud registration window

2. Select a way to pick control points. Control points, picked by clicking by default, can also

be picked by identifying the center of the spherical target or identifying the center of the

planar target. Control points can also be imported in a .txt, .csv, .xls, or .xlsx file. Operation

procedures for the three pickingmethods are as follows:



41 ©2024 FJDynamics. All rights reserved.

FJD Trion Model Point Cloud Processing Software User Manual

（a） By clicking

 Move the cursor to the view area, and the cursor changes into a hand cursor.

 Pick control points in the source point cloud, and they are shown in the list with their

coordinates and numbered A0, A1, A2, and so on. Corresponding control points picked in the

target point cloud are numbered R0, R1, R2, and so on.

（b） By identifying the center of the planar target

 Move the cursor to the view area, and the cursor changes into a hand cursor. Click the

center of the planar target.

 If the center of the planar target is identified, the control point list is updated

accordingly.

 If the center of the planar target is not identified, the cursor changes into a hand cursor

again.

（c） By identifying the center of the spherical target

 The procedure is the same as that for identifying the center of the planar target.

3. To help better pick points in the source point cloud, you can hide the target point cloud by
deselecting the Show target point cloud checkbox. After picking the control points in the
source point cloud, select their corresponding points in the target point cloud, as shown
below.

Figure 69. Picking points in the source point cloud

4. When the same number of control points are selected in the source and target point

clouds and the number is greater than three, the errors are calculated automatically. You

can modify the control point coordinates and click Preview to refresh the display.
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Figure 70. Registration preview

5. Click Apply to complete the point cloud registration.

Figure 71. Transformation parameters

Figure 72. Registration result

6. If the preview effect is not satisfactory, click Reset to adjust the control point coordinates

or delete control points, and register again. When you delete a control point in the source

point cloud, it prompts "Do you want to delete the equivalent reference point as well?".

When you delete a control point in the target point cloud, it prompts "Do you want to

delete the equivalent aligned point as well?". You can decide according to your need.
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Figure 73. Prompt for deleting the control point in the source point cloud

Figure 74. Prompt for deleting the control point in the target point cloud

7.3.2 Merge
Description:
Merges two or more point clouds into one.
Operation procedure:
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1. Open the two point clouds to be merged under Objects, as shown below.

Figure 75. Point cloud 1

Figure 76. Point cloud 2

2. Hold down the Ctrl key and select the two point clouds.

3. Click , and the following window appears. Click OK to merge the clouds. Themerging

effect is as shown below.
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Figure 77. Merging confirmation window

Figure 78. Point clouds merged

7.4 Transformation
7.4.1 Coordinate Transformation
Coordinate transformation refers to the process of transforming the coordinate system of a

point cloud to another coordinate system. To process and analyze point clouds, you need to

transform the original coordinate system of a point cloud, whichmay be the scanner

coordinate system, to a world coordinate system, for example, the GPS coordinate system.

Description:

Transforms from a source coordinate system to a target coordinate system.

Operation procedure:

1. Select a file under Objects, and click to open the Coordinate transformation window. It

supports both unknown and knownmatrix transformation. Select Unknownmatrix, and

calculate thematrix through selected points.
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Figure 79. Coordinate transformation window

2. Pick the alignment points by clicking, identifying the center of the spherical target, or
identifying the center of the planar target. Refer to 7.3.1 Point Cloud Registration for
details of the three pickingmethods.

Figure 80. Control points picked by clicking
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3. Enter the actual coordinates of the picked points by importing a file or inputting manually.
You can import the actual coordinates in a .txt, .csv, .xls, or .xlsx file. You can also click
+Add, double-click the table, and input the coordinates.

Figure 81. Entering the actual coordinates

4. When the number of the sets of actual coordinates is the same as the number of the
alignment points and the number is greater than three, the errors are calculated
automatically. You can modify the alignment points and the actual coordinates and click
Preview to refresh the display.

5. Click Apply. Transformationmatrix parameters are displayed after the coordinate
transformation is completed. Click Save to export the parameters.

Figure 82. Transformation parameters
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6. When the target coordinate system is the same as that in the last operation, select Known
matrix, and click Import to import matrix parameters. Click Preview to view the
transformation result, and click Apply to confirm the transformation.

Figure 83. Knownmatrix transformation

7. If the transformation is not satisfactory, click Reset to adjust or delete the alignment
points and the actual coordinates, and transform again. When you delete an alignment
point, it prompts "Do you want to delete the equivalent reference point as well?". When
you delete the actual coordinates, it prompts "Do you want to delete the equivalent
aligned point as well?". You can decide according to your need.

Figure 84. Prompt for deleting an alignment point
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Figure 85. Prompt for deleting the actual coordinates

Note:
Select coordinate point pairs with a smaller residual to get better transformation results.

Points picked from a point cloud are hidden when the point cloud is hidden.

7.4.2 Translation/Rotation
Description:

Rotates or translates a point cloud in any way, or rotates or translates the point cloud along

an axis by a set value.

Operation procedure for rotation:

1. Select a file under Objects to activate the Translation/Rotation function .

2. Press the left mouse button and drag to rotate the point cloud.

Note: Five rotationmodes are available. If you select X, Y, or Z, you can press the left mouse

button and drag to rotate the point cloud around the X axis, Y axis, or Z axis respectively. If

you select XYZ, you can rotate the point cloud without restrictions. If you select None, the

point cloud cannot be rotated in any direction.
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Figure 86. Selecting a rotationmode

3. Click to pause the translation/rotation and enter the preview mode, and the icon

changes into . Click to resume the translation/rotation. Note: In the previewmode,

you can translate and rotate the point cloud without restrictions.

Figure 87. Pausing the translation/rotation

Figure 88. Resuming the translation/rotation

4. Click to apply the rotation, or click to exit the translation/rotationmode and

restore the initial state. If the rotation is not satisfactory, click to restore the initial

state and rotate again.

Operation procedure for translation:

1. Select a file under Objects to activate the Translation/Rotation function . Press the

right mouse button and drag to translate the point cloud.

Note: Translate the point cloud along the selected one or more axes. For example, if you

select X, you can press the right mouse button and drag to translate the point cloud along the

X axis.

Figure 89. Selecting a translationmode

2. Click to pause the translation/rotation and enter the previewmode, and the icon

changes into . Click to resume the translation/rotation. Note: In the previewmode,

you can translate and rotate the point cloud without restrictions.

Figure 90. Pausing the translation/rotation
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Figure 91. Resuming the translation/rotation

3. To translate or rotate more accurately: select the coordinate axis along which the rotation

or translation takes place, enter the rotation angle or translation distance, and click

(clockwise rotation), (anticlockwise rotation), (positive translation), or (negative

translation).

Figure 92. Accurate translation/rotation

4. Click to apply the translation, or click to exit the translation/rotationmode and

restore the initial state. If the translation is not satisfactory, click to restore the initial

state and translate again.

7.4.3 Elevation Fitting
Description:

Transforms the geodetic datum height to the normal height in a local elevation coordinate

system for easy understanding.

Operation procedure

1. Select a file under Objects, and click . Fitting with unknown and known parameters are

supported.

2. When parameters are unknown, select Unknown parameters, set Fit Method to Fixed

difference, Plane fitting, Quadric surface fitting, or Cubic surface fitting, import control

point coordinates in a .txt, or .xlxs file or manually add them, and then set the data

storage location. Coordinates are listed in the X(E), Y(N), Z(H), and Z(h) columns.
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Figure 93. Fitting with unknown parameters

3. When parameters are known, select Known parameters, import parameters, and then set

the data storage location.

Figure 94. Fitting with known parameters

4. Click Calculate, and the calculation progress is displayed. When the calculation is

completed, click Save to save parameters into a file named original point cloud file

name_fitted_system time, and click OK to close the window.
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Figure 95. Fitting parameters

5. Fitting parameters are applied automatically after the calculation. A point cloud file

named original point cloud file name.fitted appears under Objects. Only the point cloud

formed after elevation fitting is automatically loaded and displayed in the 3D view area.

7.5 Quality Analysis
7.5.1 Accuracy Verification
Description:

Compares known coordinates of control points with scanned coordinates of such points to

obtain the elevation and plane accuracy of the scanning.

Elevation accuracy verification procedure:

1. Click the Start tab and select Accuracy Verification.

2. Select Elevation as the comparison type and import control points in a .txt, .csv, .xls,

or .xlsx file, which lists the data in the ID, X(E), Y(N), and Z(H) columns.
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Figure 96. Elevation accuracy verification window

3. Select a control point row and click Up, Down, or Delete tomove it up or down or delete it.

4. Set the parameters, and click Calculate. When the calculation is completed, the accuracy

verification window disappears, and the Reports window appears.

Figure 97. Elevation accuracy verification result window

5. Click Export to export the verification result into a .txt or .xlsx file.

Elevation and plane accuracy verification procedure:
1. Click the Start tab and select Accuracy Verification.
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2. Select Elevation&Plane as the comparison type and import a control point file. Select the
points corresponding to the control points from the point cloud. The scanned coordinates
of the selected points are shown in the Pick point information table. Select a row and click
Up, Down, or Delete tomove it up or down or delete it.

Figure 98. Elevation & plane accuracy verification window

3. Click any control point row and click Delete to delete it.

4. Set the parameters, and click Calculate. When the calculation is completed, the accuracy

verification window disappears, and the Reports window appears. Click Elevation

Accuracy or Plane Accuracy to show different verification results. Select Ds, X, or Y for

Display Deviation to show errors in different directions.
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Figure 99. Elevation and plane accuracy verification result window

Note:

 The elevation accuracy verification result includes the average Dz, max. Dz, min. Dz,

and elevation RMSE.

 The plane accuracy verification result includes the average Dx, max. Dx, min. Dx,

average Dy, max. Dy, min. Dy, plane average value, and plane RMSE.

5. Click Export to export the elevation or plane accuracy verification result.

Note:

 You can drag the accuracy verification window outside themain interface, to provide

more space for point cloud operations.

 Double-click any point ID on the picked point or actual coordinate list to show the

point in the center of the 3D view area.



57 ©2024 FJDynamics. All rights reserved.

FJD Trion Model Point Cloud Processing Software User Manual

7.5.2 Profile Analysis
Description:

Creates vertical or horizontal profiles of point clouds obtained from scanning in different

views and measures the profile length, height, and slope, to evaluate the quality of single

point clouds and the registration precision of multiple point clouds.

Operation procedure:

1. Select a point cloud file under Objects.

2. Click the Start tab, and select Profile Analysis.

3. Select (arbitrary-view vertical slice), (top-view vertical slice), or (front-view

horizontal slice).

Figure 100. Profile analysis window

4. Click anywhere on the 3D view area to hide the profile analysis window. Then, click to

select as many points as you need in the 3D view area to create a profile. Right-click to end

the selection, or press the Esc key to undo all the point selection for the current profile.

The following figures show the profile creating process and the profile analysis window

after profile creation.
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Figure 101. Creating a horizontal slice profile

Figure 102. Profile display window

5. Profile measurement is enabled by default when a profile is created. Click any two points
in the profile view area to measure the slope, length, and height. The current measured
values are shown in the upper right corner of the profile view area until the next
measurement is completed.

Figure 103. Profile measurement window
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6. Adjust the Offset(m) value to offset a profile. When the value is 0, the profile does not

offset. A positive value indicates a positive offset, while a negative value means a negative

offset. The offset direction sets themoving direction of a slice. A vertical slice can offset in

x or y direction, while a horizontal slice can offset in x or z direction. To modify the profile

width, adjust the Width(m) value, or click the profile and drag its borders. The following

figure shows that a profile is selected in the intensity rendering mode.

Figure 104. Adjusting the profile width

7. Multiple profiles can be created and color-coded. Select the required profile from the

profile list.

Figure 105. Multiple profiles created from the same point cloud

8. Profiles can be created frommultiple color-coded point clouds. For example,

indicates that the profile is created from two point clouds in red and green respectively.
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Figure 106. Profile created from two point clouds

Note:

 Profile analysis is not available when the point clouds are selected from different

coordinate systems.

Figure 107. Prompt for unavailable profile analysis

 The profile can be rendered in the rendering mode applied.

Figure 108. Profile after and before rendering
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7.5.3 Density Measurement
Description:

Obtains the number of points per unit area. It shows the spatial distribution and
concentration of points to evaluate the device performance and applicable scenarios.
Operation procedure:

1. Select a point cloud file under Objects.

2. Click the Start tab, and select . The following window appears.

Figure 109. Density measurement

3. When the hand cursor appears, click the point cloud to obtain the density of the

corresponding area.

Figure 110. Density measurement result

4. Click OK or the exit button in the upper right corner to exit the feature.
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Note:

• Density measurement is unavailable when you click the area of the view other than the

point cloud.

• When you change the length, both the width and the area are updated. The width is

always the same as the length.

7.6 Project Templates
7.6.1 Queue Processing
Description:

Allows processing multiple compressed files at the same time. It is currently available for

point cloudmapping.

Operation procedure:

1. Click on the Start tab, and the queue processing window appears. Set the function

option, device model, scanning scene, mapping mode, RTK fusion, and reconstruction

range, and click Next.

2. Select no more than 10 compressed files for mapping.
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Figure 111. Queue processing for mapping

3. Click Start to start themapping. The parameter setting window disappears and the

progress window appears. The progress bar may show the status of completed, in

progress, or failed.

Figure 112. Queue processing progress

4. When all tasks are completed, the progress window disappears and the window for

selecting data to load appears. Select data, and click OK.
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Figure 113. Selecting data to load

Note:

• Amaximum of 10 tasks can be processed at a time.

• Ensure that there is sufficient memory available before queue processing.
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8 Edit

8.1 Sampling
8.1.1 Subsample
Description:

Presents the features of the ground and objects with fewer points and achieves a balance

between the point cloud density and the accuracy to greatly reduce the redundant data,

improve the computing efficiency, and save the storage space. Subsampling can be based on

the distance, density, or spatial structure.

Operation procedure:

1. Select a file under Objects.

2. Click .

3. Select a mode, set the parameter, and click OK.

Figure 114. Cloud subsampling

The following figures show the effects before and after subsampling in different modes. When

the Density-basedmode is selected, the smaller the parameter, the fewer the points remained.

When the Distance-basedmode is selected, the larger the parameter, the fewer the points

remained. When the Spatial structuremode is selected, the smaller the parameter, the fewer

the points remained.
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Figure 115. Raw data

Figure 116. Distance-based subsampling

Figure 117. Density-based subsampling
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Figure 118. Spatial structure-based subsampling

8.2 Segment
8.2.1 Clip by Path
Description:

Clips the selected point clouds based on the scanning path. It is mainly used to remove

abnormal point clouds that are generated because the scanner stays at a position for too long

or follows an unreasonable path.

Operation procedure:

1. While pressing the Ctrl key, select a point cloud file and its corresponding scanning path

file under Objects.

2. Click on the Edit tab to open the toolbar. Both the point cloud and the path are

displayed in the 3D view area by default. Click to hide the point cloud. Pick any two

points on the path, and the chronologically ascending section of the path is selected. If

the wrong path section is selected, click to unselect it.
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Figure 119. Path selected

3. Click or to clip the point cloud corresponding to the path section. The new point

cloud generated after clipping is displayed automatically in the 3D view area.

4. Click to restore the original point cloud, or click to save the clipping result.

5. Click to exit the clipping operation.

Figure 120. Point cloud before clipping

Figure 121. Point cloud after clipping
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Note:

 Both a point cloud and its corresponding path data must be selected to enable the feature

of clipping by path.

 The mismatch between the point cloud and the path data will result in clipping failure or

incorrect clipping.

8.3 Classification
Description:

Classifies the point clouds by scenario. This part covers five features, which are Outdoor,
Indoor, Manual, Extract by Class, and Floor. The Outdoor scenario includes Trees and the
Ground. The Indoor scenario includes Wall, Floor, and Ceiling.

8.3.1 Outdoor
Operation procedure:

1. Select a point cloud file under Objects to activate the outdoor classification feature.

2. Click , and the following window appears. The ground types include Flat, Gentle slope,

and Steep slope. The extraction accuracy is inversely proportional to the steepness. The

steeper the slope, the smaller the extraction accuracy.

Figure 122. Outdoor classification

3. Select Flat, and then click OK to extract the ground cloud. The ground and other elements

are extracted as below.
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Figure 123. Raw point cloud

Figure 124. Ground extracted

Figure 125. Other elements extracted

8.3.2 Indoor
Operation procedure:

1. Select a point cloud file under Objects to activate the indoor classification feature.

2. Click , and the following window appears.
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Figure 126. Indoor classification

3. Select one or more of Wall, Floor, and Ceiling, and then click OK to extract the clouds of
the corresponding types. The walls, floor, and ceiling are extracted as below.

(a) Raw point cloud; (b) walls extracted; (c) floor extracted; (d) ceiling extracted

Figure 127. Indoor classification and extraction

8.3.3 Manual
Description:
Selects portions of a point cloud with different tools and classifies them.
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Operation procedure:
1. Select a point cloud file under Objects.
2. Click on the Edit tab, and the following window appears. The point cloud is rendered

by classification.

Figure 128. Manual classification (no data selected)

3. Click any selection tool to select a portion of the point cloud, and all the classes of the
selected portion are automatically displayed under Original Class. The , , and OK
buttons, and the Class Name and Class color fields become activated.

4. The selected portion is highlighted in red, and multiple portions can be selected. Click
to undo the previous selection, or click to undo all the selections.

5. The unclassified portion is selected by default. You can also select other classes to change
the class settings.
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Figure 129. Manual classification (data selected)

6. The class color varies with the class name. Click the class color box to reset the color.
7. Click OK to complete the settings. The point cloud becomes unselected and is colored as

set in the 3D view area.
8. Click the close icon in the upper right corner of the Manual Classification window to exit

themanual classification. The point cloud is rendered by classification by default.

Figure 130. Manual classification result
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Note:

 When no portion of the point cloud is selected, the class options are not displayed, Class

Name is Unclassified, the class color is white, and the OK button is disabled.

 When the point cloud has multiple classes, classification is to be performed on the

unclassified portion by default, and you can select other classes as required.

8.3.4 Extract by Class
Description:
Extract points of a certain class or classes to generate point cloud subsets of different classes.

Operation procedure:
1. Select a point cloud file under Objects.
2. Click on the Edit tab.
3. The point cloud is rendered by classification. The following window appears.

Figure 131. Extracting the data

4. The above window disappears when the extraction is completed. The extracted point
cloud is displayed, and the original point cloud is hidden.

5. The extracted point cloud is named after the class name and is at the same level as the
original point cloud on the file list.
The following figure shows the vegetation and buildings extracted from the point cloud
after the manual classification.
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Figure 132. Extraction by class

8.3.5 Floor
Operation procedure:

1. Select a point cloud file under Objects to activate the floor extraction feature.

2. Click , and the following window appears.

Figure 133. Floor extraction

3. Set the Recursive Plane Point Proportion and click OK to extract the floor data, as shown
below.
Note: The higher the recursive plane point proportion, the weaker the ability to detect
irregular slabs.
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Figure 134. Floor extracted

8.4 Note
Description:
Adds text or image notes to the selected point.
Operation procedure:
1. Select a point cloud file under Objects to activate the notes feature. Click , and the

cursor pattern in the 3D view area changes from to .
2. Click a point to add the title, details, and images as shown below.

Figure 135. Adding notes

3. Click OK, and the note appears under Objects and also next to the point as a label, as

shown below. Double-click a label to see the details or edit it.
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Figure 136. Note label

8.5 Triangular Mesh
8.5.1 Triangulation
Description:

Connects the scanned points into triangles according to certain rules, forming a mesh without

overlapping triangles. Themesh density varies with the curvature of the object surface. Two

triangulation types are supported: TIN and Surface Triangular Mesh.

Operation procedure:

1. Select a point cloud file under Objects to activate themesh creation feature.

2. Click .

3. Select the triangulation type, set the parameter, and click OK.

Figure 137. Creating a TIN mesh
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Figure 138. Creating a surface triangular mesh

Figure 139. Raw point cloud

Figure 140. Mesh created

8.5.2 Contours
Description:

Extracts contour lines from a point cloud to reflect the topographic changes of a surveyed

area.

Operation procedure:

1. Select a point cloud file under Objects.

2. Click on the Edit tab, and the following window appears. The display settings are

collapsed by default.
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Figure 141. Contour generation settings

3. Complete the generation settings and display settings including the contour color, and

the line width and color of the primary contour and index contour.

Figure 142. Contour display settings

4. Click Preview to display the generated contour lines in the 3D view area.
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Figure 143. Preview of contour lines in custom colors

Figure 144. Preview of contour lines in point cloud colors

5. If the preview result is satisfactory, click Save to generate the contour lines. Then, only the

contour lines are displayed in the 3D view area. The contour lines can be exported to a

DXF file, which can be imported in other third-party software.

Parameters:

• Grid spacing: grid step. You can use this parameter to check whether the grid is too big or

too small before generating it.

• Minimum elevation: minimum value of elevation.

• Maximum elevation: maximum value of elevation.

• Contour interval: height difference between two adjacent contour lines.

• Min. number of vertices: minimum number of vertices per contour line, used to remove

small contours such as trees and cars.
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8.5.3 Fill Holes
Description:

Fills holes of a triangular mesh through parameter setting to obtain an enclosedmesh.

Operation procedure:

6. Select a triangular mesh file under Objects.

7. Click on the Edit tab, and the following window appears.

Figure 145. Setting the parameter

8. Click OK to start filling holes. The following window appears. When the process is

completed, the window disappears.

Figure 146. Filling holes

The following figure shows a triangular mesh with holes filled.
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Figure 147. Triangular mesh with holes filled

8.5.4 Smooth
Description:

Adjusts the coordinates of points in the data set and divides polygons on themesh to smooth

the selected mesh and improve the appearance of themesh and the shape of the cell data set.

After smoothing, the data set changes in geometry, not in topology. Mesh smoothing can

improve the appearance of isosurfaces and remove surface noise, thereby improving the

model appearance dynamically.

Operation procedure:

1. Select a mesh file under Objects to activate the smoothing feature.

2. Click , and the following window appears.

3. Set the high, medium, or low smoothness grade, and click OK. The original mesh and the

mesh smoothed are shown below. The higher smoothness grade, the higher degree of

smoothing, and themore details lost; the lower smoothness grade, the lower degree of

smoothing, and the less details lost.

Figure 148. Mesh smoothing
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Figure 149. Original mesh

Figure 150. Mesh smoothed

8.5.5 Sample
Description:
Samples the vertices of themesh according to certain rules to reduce the size of mesh data
and avoid redundant data resulting from over-expression. The vertices can be sampled by
percentage or grid.
Operation procedure:
1. Select a mesh file under Objects to activate the sampling feature.
2. Click , and the following window appears.
3. Select the sampling mode, set the parameters, and then click OK.

Figure 151. Sampling
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(a) Original mesh; (b) sampling by percentage; (c) sampling by grid

Figure 152. Sampling results

8.6 Volume Calculation
8.6.1 Enclosed Volume
Description:

Constructs a surface triangular mesh from the point cloud of an object to measure its volume.

It is applicable to scenarios such as tanks, mine tunnels, mine pits, and karst caves.

Operation procedure:

1. Select a surface triangular mesh file under Objects.

2. Click on the Edit tab, and the volume calculation result is shown as below.
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Figure 153. Calculation result (with holes)

Note:

The enclosed volume calculation works better in scenarios with enclosed volume and may

have large errors when used in other scenarios.

8.6.2 Grids Volume
Description:

Calculates the volume and surface area according to the point cloud. This function can be

used in scenarios such as cut and fill, piles, mining areas, caves, cultural relics protection, and

vessel displacement calculation.

Operation procedure:

1. Select a point cloud file under Objects to activate the volume calculation feature.

2. Click , and the following window appears.
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Figure 154. Volume calculation

3. Set the constant and plane position. When Constant is set, Plane position is set to the

value of the lowest plane in the corresponding direction by default and can be adjusted

based on actual conditions.

4. Select the calculationmethod from Leave empty, Minimum height, Average height,

Maximum height, User specified value, and Interpolate.

5. Set the grid parameters.

Step: Side length of the square, inm. The smaller step, the higher calculation accuracy.

Cell height: Method of calculating the cell height when there are different points on the

cell. The options are Minimum height, Average height, and Maximum height.

6. After parameter settings, click Calculation to obtain the volume, floor area, added volume,

and removed volume.
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Figure 155. Volume calculation results

Note:

When Constant is set to Custom, a projection plane is created by picking points on the point

cloud and used as the basis for calculation of the volume, floor area, and more.

Figure 156. Volume calculation results with a custom constant

8.6.3 Two-phase Comparison
Description:

Calculates the volume difference of two point clouds.

Operation procedure:
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1. Select two point cloud files under Objects to activate the two-phase comparison feature.

Click , and the following window appears.

Figure 157. Two-phase comparison settings

2. By default, the first file selected is the initial state point cloud file, and the second file

selected is the current state point cloud file.

3. Click Calculation, and the calculation result window appears. You can change the

parameters, and click Calculation again. The calculation results are updated on the

window.

Figure 158. Two-phase comparison results
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9 Display

9.1 View
9.1.1 Background
Description:

Changes the background color of the view area to your preferences.

Operation procedure:

1. Click , select a color, and then click OK to apply it. The default background color is

black. The display effects before and after changing the background color are shown

below.

Figure 159. Changing the background color

Figure 160. Default background color
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Figure 161. Background color changed

9.1.2 Direction
Displays views of files opened under Objects. Click , and select a view from the drop-down
menu.
 3D View
Description:
Displays the data in the 3D view.
Operation procedure:
Click 2D to change it into 3D, and the data is displayed in the 3D view, as shown below:

Figure 162. 3D view
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 2D View
Description:
Displays the data in the 2D view.
Operation procedure:
Click 3D to change it into 2D, and the data is displayed in the 2D view, as shown below:

Figure 163. 2D view

 Left Side View
Description:
Select Left Side View to obtain the 3D data on the Y-Z plane from -X to +X direction.
Operation procedure:
 Click to show the following view:

Figure 164. Left side view
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 Right Side View

Description:

Select Right Side View to obtain the 3D data on the Y-Z plane from +X to -X direction.

Operation procedure:

 Click to show the following view:

Figure 165. Right side view

 Front View

Description:

Select Front View to obtain the 3D data on the X-Z plane from -Y to +Y direction.

Operation procedure:

 Click to show the following view:

Figure 166. Front view
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 Back View

Description:

Select Back View to obtain the 3D data on the X-Z plane from +Y to -Y direction.

Operation procedure:

 Click to show the following view:

Figure 167. Back view

 Top View

Description:

Select Top View to obtain the 3D data on the X-Y plane from +Z to -Z direction.

Operation procedure:

 Click to show the following view:

Figure 168. Top view
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 Bottom View

Description:

Select Bottom View to obtain the 3D data on the X-Y plane from -Z to +Z direction.

Operation procedure:

 Click to show the following view:

Figure 169. Bottom view

 Orthographic Projection

Description:

Orthographic projection, also known as orthogonal projection, is a means of representing

three-dimensional objects in two dimensions. It is a type of parallel projection where all the

projection lines are orthogonal to the projection plane, resulting in the cuboid-shaped view

frustum. Regardless of its distance from a virtual camera, the projected object appears the

same size on the screen. It is commonly used in blueprinting and computer aided design.

Operation procedure:

 Click , and the point cloud is displayed as follows.

Figure 170. Orthographic projection effect

 Perspective Projection
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Description:

In perspective projection, the projection size of an object is negatively related to its distance

from the viewpoint. Its view frustum is shaped like a truncated pyramid. It is widely used for

animation, visual simulation, and many other scenarios requiring a true reflection of objects.

Operation procedure:

 Click , and the point cloud is displayed as follows.

Figure 171. Perspective projection effect

Note:

The system switches to the orthographic projection effect to ensure the readability of any 2D

data in the 3D view area.

9.1.3 Clipping Box
Description:

Adjusts the dimensions and position of a clipping box to show the points inside the box and

hide the points outside the box. The point cloud subset inside or outside the box can be

further clipped to form a new cloud. It is often used for denoising or extracting required zones

in certain scenarios.

Operation procedure:

1. Select a point cloud file under Objects.
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2. Click the Display tab, and select Clipping Box. Before any operation, , , , and

are disabled, and the initial clipping box completely overlaps with the point cloud

bounding box.

Figure 172. Initial clipping box

3. Click to set the box dimensions. Click to shift the box by the box length,

width, or height in the -X, +X, -Y, +Y, -Z, or +Z direction. Drag the arrow tips to adjust the

box face positions, and use the tori to rotate the box around the arrow axes. Drag to

translate the whole box. You can hide points as required through the preceding

operations.

Figure 173. Effect of hiding the top of the point cloud
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4. Once the clipping box is defined, click or to keep points inside or outside the
box. Click to restore the original point cloud if you need before clicking . Click
and click to exit the clipping box operation.

Note:

The clipping box can work with clipping, registration, coordinate transformation, manual

classification, and accuracy verification to hide points blocking the planar target, spherical

target, and public features, so you can accurately select information on relevant features and

targets. The registration, coordinate transformation, manual classification, and accuracy

verification features must be started before you can use themwith the clipping box. This

requirement does not apply to the clipping feature. When used with other features, the , ,

and buttons of the clipping box are disabled.

9.2 Point Display
With this feature, you can change the point cloud rendering mode and set the color scale,

point size, and display range to meet requirements of different scenarios.

9.2.1 RGB
Description:

Shows the original RGB colors of a point cloud.
Operation procedure:
1. Select a file under Objects.
2. Click RGB on the Display tab, and the point cloud is displayed in RGB colors.

Figure 174. RGB display



©2024 FJDynamics. All rights reserved. 98

FJD Trion Model Point Cloud Processing Software User Manual

9.2.2 Elevation
Description:

Shows the elevation variation of a point cloud through changes of colors.
Operation procedure:
1. Select a file under Objects.
2. On the Display tab, click Elevation, and the point cloud is rendered by elevation.
3. Click Settings to change the color scale and display range, and click OK. The point cloud is

updated accordingly in the 3D view area.

Figure 175. Rendering by elevation

9.2.3 Intensity
Description:

Shows the intensity variation of a point cloud through changes of colors.

Operation procedure:

1. Select a file under Objects.

2. On the Display tab, click Intensity, and the point cloud is rendered by intensity.

3. Click Settings to change the color scale and display range, and click OK. The point cloud is

updated accordingly in the 3D view area.

Figure 176. Rendering by intensity
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9.2.4 Time
Description:

Shows the time variation of a point cloud through changes of colors.

Operation procedure:

1. Select a file under Objects.

2. On the Display tab, click Time, and the point cloud is rendered by time.

3. Click Settings to change the color scale and display range, and click OK. The point cloud is

updated accordingly in the 3D view area.

Figure 177. Rendering by time

9.2.5 Classification
Description:
Shows the classification variation of a point cloud through changes of colors.
Operation procedure:
1. Select a file under Objects.
2. On the Display tab, click Classification, and the point cloud is rendered by classification.
3. Click Settings to change the color scale and display range, and click OK. The point cloud is

updated accordingly in the 3D view area.
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Figure 178. Rendering by classification

9.2.6 User Data
Description:

Shows the user data variation of a point cloud through changes of colors.

Operation procedure:

1. Select a file under Objects.

2. On the Display tab, click User data, and the point cloud is rendered by user data.

3. Click Settings to change the color scale and display range, and click OK. The point cloud is

updated accordingly in the 3D view area.

Figure 179. Rendering by user data
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9.2.7 Set Unique
Description:
Renders a point cloud with a specified color.
Operation procedure:
1. Select a file under Objects.
2. On the Display tab, click Set unique, and the point cloud is rendered in the specified color.
3. The color scale and display range cannot be changed in the Set uniquemode.

Figure 180. Rendering in a specified color

9.2.8 Blend
Description:

Renders a point cloud by elevation and intensity.

Operation procedure:

1. Select a file under Objects, and click the Display tab.

2. Click Blend, and the point cloud is rendered by elevation and intensity.

Figure 181. Rendering by elevation and intensity
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9.2.9 Point Size
Description:

Sets the point size of any 3D point cloud in the software.

Operation procedure:

1. Click Point size and select a proper value from the drop-down list. The following figures

show the display effects of different point sizes. The point size is 1 by default and can be

set to Auto to ensure the display effect when you zoom in or out on the point cloud.

Figure 182. Before changing the point size

Figure 183. After changing the point size
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9.2.10 Settings
Description:
Sets the display scalar and saturation based on the selected renderingmode of the point
cloud.
Operation procedure:
1. Select a file under Objects.
2. Click one rendering mode.
3. Click to adjust the display scalar and saturation. The following figure shows the Scalar

Settings window for rendering by time.

Figure 184. Scalar settings for rendering by time

Note:

 The color scale changes according to what you select from the Displays scalar drop-down
list.

 Drag the slider or enter values to adjust the saturation. The point cloud 3D view is updated
accordingly.

 By default, the color scale is blue-green-yellow-red, and the range is specified by the upper
and lower limits of the corresponding point cloud data.

9.2.11 Boundary Reinforcement
Description:
Works with other rendering modes to enhance the outline display of point cloud features.
Operation procedure:
1. Select a file under Objects.
2. On the Display tab, click . The following figures show the effects before and after

boundary reinforcement.
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Figure 185. Before boundary reinforcement

Figure 186. After boundary reinforcement

9.2.12 Light Enhancement
Description:
Enhances point cloud visualization to better reflect the features and boundaries.
Operation procedure:
1. Select a file under Objects.
2. On the Display tab, click , and the following window appears.

Figure 187. Shadow processing progress window
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Figure 188. Before light enhancement

Figure 189. After light enhancement
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10 Drawing

10.1 Slice
10.1.1 Slice Plane
Description:

Slices a point cloud along an axis or vertically to the screen to obtain a plane of a certain

thickness.

Operation procedure:

1. Select a file under Objects, and click Drawing.

2. Click , and the following window appears.

Figure 190. Plane slicing window
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3. Click Along Axis, select X, Y, or Z as the slicing direction, adjust the plane position by
entering values or dragging the slider, set the plane thickness, and click Create. The result
is shown below. A Slice plane file is added to the file list under Objects.

Figure 191. Result of slicing along an axis

4. Select Vertical to Screen, and select two points on the point cloud to create a slice. The
slice is displayed in the 2D view area. Drag the slider to set the slice offset, and change the
thickness value to adjust its thickness. Double-click tomodify the corresponding point
coordinate in the table as shown below. Click Create to obtain the slice, and the file list is
updated under Objects.

Figure 192. Result of slicing vertically to the screen
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Figure 193. Editing coordinates

10.2 Drawing Management
10.2.1 Draw
Description:

Enables drawing related features to draw 2D vector graphics.

Operation procedure:

1. Select a "Slice plane" or "Vectors" file under Objects.

2. Click to enable drawing related features. The slice is projected into a 2D view, where

you can draw vector graphics.

10.2.2 Save
Description:

Saves the vector graphics.

10.2.3 Undo
Description:

Undoes the last drawing action. Click it multiple times to undomore than one action.

10.2.4 Redo
Description:

Redoes the last undone action. Click it multiple times to redomore than one action.
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10.2.5 Delete
Description:

Deletes the selected vector graphics.

10.2.6 Exit
Description:

Exits the vector graphic drawing mode. Then, the graphic drawn is shown in a 3D view and

cannot be edited.

10.3 Fitting
10.3.1 Extract Contours
Description:

Obtains 2D contours of a slice of a point cloud through automatic fitting.

Operation procedure:

1. Select a "Slice plane" file under Objects, click the Drawing tab, and click Draw.

2. Click , and the 3D view is switched to the 2D view. The 2D view is the projection plane

perpendicular to the slice.

3. The message "Waiting..." appears during the extraction and disappears when the

extraction is completed. Click Save, and a file named "Vectors" is added to the file list

under Objects. The current view is also updated.

Figure 194. Extracted contours
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10.4 Graphic Drawing
10.4.1 Straight Line
Description:

Draws a straight line.

Operation procedure:

1. Click in the Graphic Drawing area, and the icon is highlighted.

2. Move the cursor to the view area to select points.

3. Click to select the first point, move the cursor to a new position, and click to select the

second point. A straight line is formed.

4. Click again to start drawing the next straight line.

10.4.2 Polyline
Description:

Draws a polyline.

Operation procedure:

1. Click in the Graphic Drawing area, and the icon is highlighted.

2. Move the cursor to the view area to select points.

3. Click to select the first point, move the cursor to a new position, and click to select the

second point. Repeat the steps to create a polyline.

4. Right-click to end the drawing. Click again to start drawing the next polyline.

10.4.3 Arc
Description:

Draws an arc.

Operation procedure:

1. Click in the Graphic Drawing area, and the icon is highlighted.

2. Move the cursor to the view area to select points.

3. Click to select the first point, move the cursor to a new position, click to select the second

point, move the cursor to another position, and click to select the third point. An arc is

formed.
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4. Click again to start drawing the next arc.

10.4.4 Rectangle
A rectangle can be drawn with two or three points.

Two-point Rectangle

Description:

Draws a rectangle by specifying the diagonal with two points.

Operation procedure:

1. In the Graphic Drawing area, click the inverted triangle beside the rectangle drawing icon

and select Two-point Rectangle, or click Two-point Rectangle directly. The icon is

highlighted.

2. Move the cursor to the view area to select points.

3. Click to select the first point, move the cursor to a new position, and click to select the

second point. A rectangle is formed with the line connecting the two points as the

diagonal.

4. Click again to start drawing the next rectangle.

Three-point Rectangle

Description:

Draws a rectangle by setting three vertices.

Operation procedure:

1. Click Three-point Rectangle in the Graphic Drawing area, and the icon is highlighted.

2. Move the cursor to the view area to select points. Click to select the first point, move the

cursor to a new position, click to select the second point, move the cursor to another

position, and click to select the third point. A rectangle is formed with the three points as

vertices.

3. Click again to start drawing the next rectangle.

10.4.5 Circle
A circle can be drawn in a 2D view with three points, two points (defining the diameter), or

one center point plus the radius.
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Three-point Circle

Description:

Draws a circle by setting three points on the circumference.

Operation procedure:

1. Click Three-point Circle in the Graphic Drawing area, and the icon is highlighted.

2. Move the cursor to the view area to select points.

3. Click to select the first point, move the cursor to a new position, click to select the second

point, move the cursor to another position, and click to select the third point. A circle is

formed with the three points on the circumference.

4. Click again to start drawing the next circle.

Two-point Circle

Description:

Draws a circle by specifying the diameter with two points.

Operation procedure:

1. In the Graphic Drawing area, click the inverted triangle beside the circle drawing icon, and

select Two-point Circle, or click Two-point Circle directly. The icon is highlighted.

2. Move the cursor to the view area to select points.

3. Click to select the first point, move the cursor to a new position, and click to select the

second point. A circle is formed with the line connecting the two points as the diameter.

4. Click again to start drawing the next circle.

Center and Radius

Description:

Draws a circle by setting the center and the radius with two points.

Operation procedure:

1. In the Graphic Drawing area, click the inverted triangle beside the circle drawing icon and

select Center and Radius, or click Center and Radius directly. The icon is highlighted.

2. Move the cursor to the view area to select points.
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3. Click to select the first point, move the cursor to a new position, and click to select the

second point. A circle is formed with the first point as the center and the line connecting

the two points as the radius.

4. Click again to start drawing the next circle.

10.5 Graphic Editing
10.5.1 Extend
Description:

Extends the selected primitive to intersect with an adjacent primitive. It is often used to
extend vector lines tomake them intersect again after automatic extraction of contours.
Operation procedure:

1. On the Drawing tab, click to activate the extend feature.

2. When the cursor hovers over a straight line, a polyline, or an arc, the software

automatically checks whether their extension lines can intersect with other primitives,

and draws dotted extension lines if necessary.

3. Click to execute the extend action. This operation can be repeated.

4. Right-click or press the Esc key to exit the feature.

Figure 195. Before extension
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Figure 196. After extension

10.5.2 Copy
Description:

Copies one or more primitives to avoid drawing the same elements repeatedly and improve

drawing efficiency.

Operation procedure:

1. On the Drawing tab, click to activate the copy feature.

2. Click to draw a rectangular area to select one or more primitives.

3. Right-click to end the selection and generate an identical set of primitives with the cursor

position as the center. The new set of primitives moves with the cursor.

4. Click again to complete the copy. This operation can be repeated.

5. Right-click or press the Esc key to exit the feature.

Figure 197. Primitive copying result
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10.5.3 Trim
Description:

Removes the selected vector lines between endpoints from primitives.

Operation procedure:

1. On the Drawing tab, click to activate the trim feature.
2. When the cursor hovers over a primitive, the primitive becomes white.
3. Click to execute the trim action. This operation can be repeated.
4. Right-click or press the Esc key to exit the feature.

Figure 198. Before trim

Figure 199. After trim

10.6 Drawing Settings
10.6.1 Object Snap
Description:

Enables or disables the object snap.

Operation procedure:

1. The Object Snap function is enabled by default to assist with graphic drawing.
2. Uncheck the box to disable the feature. The software then does not snap endpoints during

drawing.
Snapping elements:
• Two endpoints and onemiddle point of a straight line.
• Every endpoint of a polyline and every middle point of every section line.
• Two endpoints, one middle point, and one center point of an arc.
• Four vertices and one center point of a rectangle, and middle points of the four edges.
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• One center point of a circle and middle points of the four reference lines.
• One pedal point of a primitive that is vertical to the line connecting the current cursor

position and one end point of the last vector line.
• Any other points on any of the above graphics. The cursor type is different from that for

snapping the above elements.
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11 Forestry
In a traditional forestry survey, the field investigations consume a lot of manpower and

materials. Especially when conducted on a large scale, the surveys not only are

labor-intensive and time-consuming, but often take the form of small-area sample

measurements, which are unsuitable for high-demanding forest survey scenarios. The

combined use of the FJD Trion S1 3D laser scanner and the FJD Trion Model point cloud

processing software makes a forestry survey more accurate and convenient.

11.1 Extract Ground Point
Description:

Classifies and extracts ground points from the forestry scenario point cloud. It is critical for

segmentation by tree.

Operation procedure:

1. Select a point cloud file under Objects.

Figure 200. Forestry scenario point cloud

2. Click on the Forestry tab, and the following window appears.



©2024 FJDynamics. All rights reserved. 118

FJD Trion Model Point Cloud Processing Software User Manual

Figure 201. Setting parameters

3. Click OK to start the extraction of ground points. The following window appears.

Figure 202. Extracting ground points

4. The above window disappears when the extraction is completed.

5. The point cloud with ground points extracted is displayed in the 3D view area. The point

cloud is rendered by classification by default.
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Figure 203. Ground points extracted

Note:

 For flat grounds, the grid step can be a little larger for efficient extraction of ground points;

while for slopes, a smaller grid step should be used.

 The ground thickness must be set based on the terrain height difference, and can be

obtained by the height measurement tool of the software when necessary.

11.2 Segment by Tree
Description:

Obtains the tree boundary from the point cloud with ground points extracted to segment the

point cloud by tree and extract the trees.

Operation procedure:

1. Select a point cloud file under Objects.

2. Click on the Forestry tab, and the following window appears.
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Figure 204. Setting parameters

3. Click OK to start the segmentation by tree. The following window appears.

Figure 205. Segmenting by tree

4. The above window disappears when the segmentation is completed. The segmentation

result rendered by tree ID is displayed in the 3D view area.

Figure 206. Segmentation result
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Parameters:

• Minimum number of points: minimum number of points per tree.

• Minimum grid edge length: It is set based on the point cloud spacing, and is often set to

the point cloud spacing.

11.3 Edit
Description:

The tree point clouds differentiated by colors are obtained through segmentation by tree.

Oversegmentation or undersegmentation may occur due to the complexity of scanning

scenarios. You can edit the segmentation result to make it more realistic.

Operation procedure:

1 Select the folder original point cloud name.segment under Objects.

2 Click on the Forestry tab, and the screen is displayed as below. By default, view 1 is a

top view of the point cloud with trees highlighted in different colors, while view 2 is a 3D

view of the selected area.

3 Select the area to edit in view 1, and view 2 is updated accordingly.

Figure 207. Tree point cloud editing screen

4 If unexpected objects are found in the selected area in view 2, click the ID labels of such
objects and then click in view 2 to set them as unclassified data.
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Figure 208. Before deleting the wrong ID labels

Figure 209. After deleting the wrong ID labels

5 If multiple trees are identified as one tree or trees are not identified, label them manually

as individual trees. On the original point cloud shown in view 1, select the portion you

want to edit and the object is displayed in view 2, and then click to label it as a tree

and assign a new tree ID.

Figure 210. Adding a new tree ID label
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6 If one tree is identified as multiple trees, click the corresponding tree ID labels in view 2

while pressing the Ctrl key, and then click to merge them into one. The new tree uses

the ID of the first selected tree.

Figure 211. Before merging

Figure 212. After merging

Note:

 A point cloud without segmentation by tree performed cannot be edited.

 When you double-click a single tree from the point cloud in the 3D view area, the file with

the corresponding tree ID is selected under Objects, so that you can edit the data directly.

 Rotation is unavailable when the data is selected in view 1.
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11.4 Property Calculation
Description:

Calculates the tree parameters, such as coordinates, tree height, DBH, and crown width,

based on the segmentation result.

Operation procedure:

1 Click the folder original point cloud name.segment, or the required tree point cloud under

Objects.

2 Click on the Forestry tab, and the following window appears. Select parameters as
required.

Figure 213. Selecting parameters

3 Click OK to start calculation. The following window appears.

Figure 214. Calculating parameters

4 The tree properties are displayed in a table after the calculation is completed. Click any

row of data in the table, and a bounding box appears for the corresponding point cloud in

the 3D view area.
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Figure 215. Calculation result preview

5 To export the tree properties, unselect the unwanted IDs and click Export Selected, or

click Export All, select the storage path, and click Save. The export file name is the

segment file folder name by default. The .xlsx, .csv, and .txt file formats are supported.

Figure 216. Export settings
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12 Appendix

12.1 Key Terms
1. Lidar: A system that emits laser beams and receives echoes to obtain 3D information of

the target. Source: GB/T 14950-2009 Terms of Photogrammetry and Remote Sensing,

4.150.

2. Light Detection and Ranging (LiDAR): An active measurement technology that, using a

fixed or mobile platform, emits laser beams to obtain information such as 3D coordinates

and reflection intensity of the surface of objects. Source: CH/T 3020-2018 Technical

Regulations for Real Scene 3D GIS Data Collection Using LiDAR, 3.2.

3. Point cloud: A collection of points distributed in a 3D space in a discrete and irregular way.

Source: T/CAGIS 5-2021 Vehicle-Mounted LIDAR Mobile Mapping System, 3.4.

12.2 High-performance Graphics Mode Settings
1. Download and install the latest graphics driver.

2. Restart the computer, and right-click the desktop and select NVIDIA Control Panel.

Figure 217. NVIDIA control panel

3. Choose Manage 3D settings > Program Settings and add "FJD Trion Model.exe" to the

high-performance graphics mode list, and then click Apply.
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Figure 218. Graphics mode settings
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13 Troubleshooting
1. The language switch (between Chinese and English) does not take effect after the

software is restarted.

Solution: This may appear when the software is installed on C drive. Right-click it and select

Run as administrator tomake the language switch take effect.

2. The Edit toolbar is gray and inactive.

Solution: Select the point cloud file to edit under Objects and the Edit toolbar becomes active.

3. The software cannot be started.

Solution: Download and install the software from the official website, and then contact the

dealer to get the encryption lock. The encryption lock is shown in the figure below.

Figure 219. Encryption lock
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